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About Abstract Plus 

Abstract Plus is a cancer data collection tool developed by the Centers for Disease Control and Prevention (CDC) and 
customized by the Wisconsin Cancer Reporting System (WCRS) to meet state reporting requirements.  It is used to 
summarize medical records into an electronic report of cancer diagnosis, staging, and first course treatment. The output 
of Abstract Plus is an electronic abstract in the format of the North American Association of Central Cancer Registries 
(NAACCR) data exchange layout or an Excel file of all data items including system fields. 

Abstracts entered into Abstract Plus are validated by Wisconsin-specific edits, allowing for interactive error correction 
while abstracting. Abstract Plus also includes Registry Plus Online Help, a collection of standard coding manuals that are 
cross-referenced, indexed, and context-linked to minimize the need for reference to printed manuals during abstracting.   

All records are saved in Microsoft Access or SQL Server databases, and all tables are password protected and encrypted.  
All users must have a User ID and password to access the abstracting features of the application, and access to 
administrative and auditor functions requires the entry of special restricted passwords. 

System Requirements  

 Microsoft Operating System, Windows 7 or later 

 Memory (RAM)  

o 1 GB RAM (32-bit computer) 

o 2 GB RAM (64-bit computer) 

 Microsoft .NET Framework 4.5 or newer 

 70 MB hard drive space 

Downloading, Installing, and Upgrading Abstract Plus 

See the WCRS Website for instructions on downloading, installing, and updating Abstract Plus. 

 

 

 

 

  

https://www.dhs.wisconsin.gov/wcrs/reporterinfo/abstractplus.htm
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Frequently Asked Questions 

Help! My organization uninstalled my Abstract Plus/reimaged my computer and I have lost all of my 
abstracts. 
First, contact your IT department and see if your backups are saved to a network drive or if you can restore 
your computer to an earlier point in time.  If you are still unable to locate or retrieve your backups, email 
Jenna Staehler and CC the appropriate parties in your IT department. 

After further review, if it is determined that your backup has been erased and there is no way of recovering it, 
WCRS can provide information on abstracts we have received from you. The format and type of information 
we provide is dependent on individual needs and circumstances and we will work with you to restore 
necessary data as possible. 

I can’t login to Abstract Plus after upgrading to the new version. 
The most common reasons users cannot login is because they had the old version uninstalled and did a fresh 
install of the new version, or because the databases containing user information are in a location the 
application does not recognize. For help, email Jenna Staehler and CC appropriate parties in your IT 
department if necessary.  

I found a bug or have suggestions on how to make Abstract Plus better. Who do I contact? 
If you encounter an error message, issue, or bug, take a screenshot of the entire application (as feasible, do 
not include PII/PHI) and include details on what you were doing when it happened, or steps on how to re-
create the issue if possible. Including more detail than not is a good rule of thumb here. 

Feedback and suggestions are greatly appreciated and are always welcome. User input is one of the largest 
driving forces in Abstract Plus development. Error messages, bugs, issues, feedback, and suggestions can all be 
sent in email to Jenna Staehler. 

  

mailto:jenna.staehler@dhs.wisconsin.gov?subject=Abstract%20Plus
mailto:jenna.staehler@dhs.wisconsin.gov?subject=Abstract%20Plus
mailto:jenna.staehler@dhs.wisconsin.gov?subject=Abstract%20Plus
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Logging In for the First Time 

After installing Abstract Plus, if you are the first person to launch the program, you will be prompted to create a new 
user account. The following directions will instruct you on how log in for the first time. 

1. Launch Abstract Plus. Result: The Create/Modify Users window opens.  

 

2. Enter your name (Last name, First Name, Middle Initial) in the User Name field, User ID (5-10 characters), and 
Initials. Click Add. 

 
 

! 

The creation of a user account is enabled only upon initial launch of the program.  If other users 
already exist in your Abstract Plus application (i.e. the program has already been launched and user 
account(s) created), you will need to have an existing user login and create a user account for you.  
Contact WCRS for instructions on how to do this if you do not already know how. 

Enter 
your: 
Name 
User ID 
Initials 

Click Add 
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3. Result: The Login window opens.  Login with your User ID and temporary password: Welcome1 

4. A Password Update message is issued that lets you know you need to change your password.  This occurs upon 
initial log in only.  Click OK.  

5. Result: The Change Password window opens. Enter the temporary password (Welcome1) as the Old Password.  
Then enter and confirm your new password. Your password must be between 8-20 characters, contain both 
numbers and letters, but no special characters. Click OK. 

 

6.  Set up three Security Questions. These are used to reset your password if you forget it. Click Submit Questions. 

7. Result: The Main Window opens, with you logged in as a general user.  

  

Welcome1 

Setup 
Questions 
and Click 
Submit 
Questions  

Welcome1 
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Changing Your Password 
From Within Abstract Plus 

1. Select Change Password from the Options Menu. Result: The Change User’s Password window opens.  

2. Enter your current password in Old Password box. Enter and confirm your new password. Your new password 
must be between 8-20 characters, contain both letters and numbers, but no special characters. Click OK. 

From the Login Screen 

1. Open Abstract Plus, enter your User ID, click in the Password box, and then click the Change Password.  

2. Enter your current password in Old Password box. Enter and confirm your new password. Your new password 
must be between 8-20 characters, contain both letters and numbers, but no special characters. Click OK. 

Click OK  

Click in the 
Password field  

Click Change 
Password  

Enter your 
User ID 

Enter and 
confirm 
your New 
Password 

Enter and 
confirm 
your New 
Password 

Click OK  

 



7 

Possible Errors when Changing Your Password 

1. Old password is incorrect. You must correctly enter your old password in order to successfully change it. Check 
to see if Caps Lock or Num Lock is on and try again. Click OK, and then correctly re-enter your old password. If 
you cannot remember your old password, follow instructions for Resetting a Forgotten Password. 

2. New passwords do not match.  The new password entered into the New Password and Confirm Password boxes 
must match exactly. Click OK, and then correctly re-enter your new password in New Password and Confirm 
Password boxes. 

3. New password does not meet specified password requirements.  Your new password must be between 8-20 
characters, contain both letters and numbers, but no special characters. Click OK, then re-enter a new password 
that meets the password requirements. 

Resetting a Forgotten Password 

1. Launch Abstract Plus, enter your User ID and click in the Password field. Then click Forgot Password. 

2. Result: The Reset User’s Password window opens. Enter the answer to each displayed question with the same 
answer you provided when you set them up. Click Validate Questions when you are finished. 

3. Result: If you answered them correctly you will be directed to the Password Reset window where you can set 
your new password. Enter and confirm your password, then click Reset Password to submit the change.  

4. Result: The Login window opens. Login with your User ID and newly created password. 
  

Click Forgot 
Password 

Answer all 
Security 
Questions. 
Then, click 
Validate 
Questions. 

Enter and 
confirm your 
New Password 

Click Reset 
Password  

Click in the 
Password field  

Enter your 
User ID 
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Updating Personal Security Questions 

1. From the Options Menu, select Update Security Questions. Result: The Update User’s Security Questions 
window opens.  

2. Select new questions with answers or submit new answers to current questions. Click Submit Questions.  

 

 

 

Enter new 
answers to 
your current 
questions or 
select and 
answer new 
questions. 

Click Submit 
Questions 
when finished. 
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Main Abstracting Window 
The Abstracting window is divided into two main sections: coded values on the left, and text fields on the right.  You can 
drag the vertical divider bar to resize panes, and expand/collapse coded value sections. 

 

Display Types 
The abstracting interface is called a display type.  A display type defines which fields and sections are displayed. WCRS 
has two display types:  1976-2017 Diagnoses and 2018-Present Diagnoses. Make sure the right display type is selected 
before entering the data.  For cases diagnosed before 2018, choose the 1976-2017 Diagnoses display.  For cases 
diagnosed 2018 or later, choose the 2018-Present Diagnoses display. 

 

 

 

 

 

  

! 

Make sure the right display type is selected before entering the 
data.  For cases diagnosed before 2018, choose the “1976-2017 
Diagnoses” display type.  For cases diagnosed 2018 or later, 
choose the “2018-Present Diagnoses” display type. 

Expand and Collapse Fields  
Using the + and - Signs 

Drag to Resize Panes 
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Fields in the Staging Section  

Summary Stage is required for all cases.  Use the SEER Summary Stage 2000 Manual to abstract cases diagnosed 2001-
2017. Use the SEER Summary Stage 2018 Manual to abstract all cases diagnosed 2018 and later. 

Collaborative Staging is required for all cases diagnosed 2004-2015 and SEER Summary Stage 2000 is required for cases 
diagnosed 2001-2017.   

Tumor Size Summary Required for all cases diagnosed 2016 and later 

Reg. Nodes Positive Required for all cases diagnosed 2004 and later 

Reg. Nodes Examined Required for all cases diagnosed 2004 and later 

Mets at DX-Bone 
Required for all cases diagnosed 2016 and later (use the CS Mets at DX-Bone field for cases 
diagnosed 2004-2015) 

Mets at DX-Brain 
Required for all cases diagnosed 2016 and later (use the CS Mets at DX-Brain field for cases 
diagnosed 2004-2015) 

Mets at DX-Distant LN Required for all cases diagnosed 2016 and later  

Mets at DX-Liver 
Required for all cases diagnosed 2016 and later (use the CS Mets at DX-Liver field for cases 
diagnosed 2004-2015) 

Mets at DX-Lung 
Required for all cases diagnosed 2016 and later (use the CS Mets at DX-Lung field for cases 
diagnosed 2004-2015) 

Mets at DX-Other Required for all cases diagnosed 2016 and later  

Summary Stage 2018 
Required for all cases diagnosed 2018 and later (use Summary Stage 2000 for cases 
diagnosed prior to 2018) 

Lymph-Vasc. Invasion Required for all cases diagnosed 2010 and later 

  

https://seer.cancer.gov/tools/ssm/ssm2000/
https://seer.cancer.gov/tools/ssm/
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Fields in the Collaborative Stage Section 
Collaborative Staging (CS) is required for all cases diagnosed 2004-2015.  CS fields are located in the CS and Site Specific 
Factors section of the 1976-2017 Diagnoses Display. 

CS Input Fields 
Once the fields of primary site and histology have been entered, each CS input data item has a special site-specific look-
up associated with it that is accessed by clicking the magnifying glass icon to the left of the field or pressing F4. 

CS Site Specific Factors 
Once you enter Primary Site, Histology, Diagnosis Date, Behavior, and any CS input field, the CS Version Input Current 
and CS Version Input Original fields are automatically populated. You can calculate CS Version Derived by clicking the F5 
button. Abstract Plus will run edits to check primary site and histology to determine if SSF25 is required for schema 
identification.   

 If SSF25 is required for the primary site and histology entered the SSF25 look-up will open for you to select a 
value.  

 If the primary site and histology initially entered are revised to result in a different schema, you will be offered 
the option of clearing all CS input fields and re-coding CS for the abstract.  

 If SSF25 is not required for the primary site and histology entered SSF25 will be automatically defaulted and 
disabled. 

Derived CS Fields 
After the appropriate CS input fields have been entered, place the cursor into any of the derived fields and click the 
calculator icon to the left of the field or press F5 to derive CS Fields 

Clear CS fields 
Upon entry of a Date of Diagnosis of 2003 and earlier, you will be offered the option of clearing all CS fields. However, 
you can clear Collaborative Staging fields at any time by right clicking on a CS field and selecting Clear Collaborate Stage 
Fields, or by pressing F9. 
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Abstracting in Abstract Plus 
Creating and Saving Abstracts 

1. Select New Abstract from the File Menu or click                    on the toolbar. Result: A new abstract opens. 

 
2. Ensure you are in the right Display Type per the diagnosis year. The available display types are 1976-2017 

Diagnoses and 2018-Present Diagnoses. 

3. Remember to Save your abstract periodically. To save an abstract, press Ctrl+S or click                on the toolbar. 
Result: The Abstract is saved and an Abstract Reference ID is assigned. Edits automatically run. See: Running 
Edits and Fixing Errors for more information on edits. 

An Abstract Reference 
ID is assigned when an 
abstract is saved and is 
displayed in two places 

Check the 
Display Type 
before you 

start! 
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Helpful Tips for Abstracting 

 Many data items offer code selection from drop-down lists.  These lists feature an auto-complete, find-as-you-
type function. To use this, type in the first letter(s) of the desired item, and the application will jump and select 
the first item that matches. In the example below, “A” was typed into the Race 1 field, and the application 
jumped to and selected American Indian, Aleutian, or Eskimo. 

 For data items with extensive listing of coded values, such as primary site, you can look up valid values. To look 
up values, click on the magnifying glass icon to the left of the data item (or press F4) to use the search feature. 

 When you look up valid values, you can enter a full or partial search term or code to search for, and then 
double-click on the code of your choice to select and enter the value in the abstract. 

 When entering text, a blue progress bar is displayed indicating how much space is left so that you can properly 
prioritize the information you are entering. 

 The Schema ID field is calculated automatically. Schemas can usually be identified by date of diagnosis, 
primary site code, and histology/behavior code alone, but occasionally, other factors are required such as 
sex, age, schema discriminators, and grade clinical.  

 
 

  

Progress Bars 

Click to 
look up 

data 

Begin typing to 
jump to an item 
and select it 

Double-click to add a 
value to your abstract 
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Running Edits and Fixing Errors 

For any abstract you can run and view edits errors by: saving the abstract, clicking                   on the toolbar, or pressing 
F8. Each time an abstract is opened or saved edits are run for accuracy and completeness. All edit errors need to be 
resolved to complete an abstract.  

You can view edits for individual fields or the entire abstract. To run edits on the full abstract, click                  on the 
toolbar, or right-click on the abstract and select Run EDITS. To view edit errors for individual data fields, right click on 
the field and select Edits Information.   

 

When you run edits, the Edit Set Results window will open and display information for edit errors that exist, or let you 
know that there are no errors.  To resolve edit errors you can click on the link to the field in the edit report, which will 
navigate you to the field in question.  You can click                     to switch from viewing edits for an indiviudal field to 
viewing edits for the entire abstract. As you correct errors you can click                  to update your results.  

The EDITS Error Count and Completion Status indicators are located at the bottom of the abstracting window and 
reflect the current edit error count and completion status of the abstract.   
 

If there are any errors within the abstract, both of these indicators will display in red. 

  
 

Once edits have been corrected, they will turn green. 

  

Click links to navigate to 
field and correct errors 

Refresh results after 
correcting errors 

Right-click and 
select Run EDITS 
to view edits for 
the full abstract 

View edit errors 
for entire abstract 

Right-click on a specific field 
and select Edits Information 
to see edits for that field 
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Find and Open Abstracts 

1. Select Open/Find Abstract from the File Menu or click                   on the toolbar. Result: The Open/Find Abstract 
window opens. 

 

 

 

 

 

 

 

 

  

 

2. Enter your search criteria and click Query. Result: A list of abstracts that meet your search criteria are listed. 

 

3. From the abstracts listed, locate the abstract of interest and open it by double-clicking the row for the abstract 
or by selecting the row for the abstract and clicking Select. Result: The selected abstract opens in the main 
window. 

 

 

Click Query 

Specify 
Search 
Criteria 

Highlight the 
Abstract  

Click 
Select 
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Copy an Abstract  

1. Make sure that you have the abstract to be copied open in the abstracting window. Click on the File menu, and 
select Copy Abstract or click                 on the toolbar. Result:  The Copy Abstract dialog opens and asks you to 
confirm that you would like to copy the abstract.  

2. Click Yes. The abstract is copied to a new Abstract Reference ID. Patient demographics from the original 
abstract are copied over. No tumor information is copied over. 

 

 

Demographics from 
the original abstract 

are copied to the 
new abstract. 
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Abstract Management 
Importing Abstracts 

You can import complete and incomplete abstracts in NAACCR format. When importing, abstracts in NAACCR V16 are 
converted to V18 and Collaborative Stage is re-derived for cases diagnosed 2004-2015.  

1. Open the Import Abstracts window by clicking the Import Icon on the toolbar or by selecting Import Abstracts 
in NAACCR Format in the File Menu. Result: The Import Abstracts in NAACCR Format window opens.  

 

2. Click the Select File and navigate to the files you want imported. Click Import.  

 

Field/Option Description 

Import File The name and location of the file of abstracts in NAACCR file format to be imported  

Total Abstracts The total number of abstracts included in the file to be imported 

Importing Abstract No. While importing, displays the sequential number of the abstract being imported 

Total Abstracts Imported While importing and upon completion, displays the total number of abstracts imported 

Layout Version The NAACCR Record Version [item #50 ]of the file to be imported  

NAACCR Abstract Type The NAACCR Record Type [item # 10] of the abstracts in the file to be imported 

File contains CrLf Informs you if import file contains Carriage Returns, or Line Feed characters  

Use Incoming File’s Export 
Status 

Check the field of Date Case Report Exported [item #2110]---if the Date Case Report 
Exported is filled, the incoming abstract will be marked as exported 

Check Abstracts’ completed 
Status for import 

Option to set the Completion Status of the imported abstracts to Complete or 
Incomplete 

 

Then, Import 

First, Select File 
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Exporting Abstracts  

You need to export your abstracts in order to submit your data to WCRS. Once they are exported they can be uploaded 
to Web Plus.  

1. Click on the File menu, and select Export Abstracts or click                 on the toolbar.  Result: The Export 
Abstracts window opens, and presents you with different options for exporting abstracts.             

2. Choose your export options, and click Select. Result: The system displays the number of abstracts that meet the 
export criteria in the lower left-hand corner of the main window, and displays a message. Click OK.  

 
 
 
 
 
 
 
 

(Instructions Continued On Next Page) 

Choose export 
options and 
click Select. 

 

Number of 
abstracts to be 
exported is 
shown 
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3. Click Preview. Result: The Export Selection Preview window opens. Click Export. 

4. Enter a file name for the export file using the following naming convention. Result: The system exports the 
abstracts into a text file provides a report for the export.   

 

 

 

 

Holding Abstracts 

You can hold abstracts to prevent them from being exported. To hold an abstract, open the abstract and check the Held 
checkbox. This will prevent the abstract from being exported. 

  

! 
File Naming Convention 

 [1st five digits of WCRS facility code]_[abstractor initials]_[date exported].txt 
Example:  01005_LAS_02022017.txt 

 

Click Preview 

Click Export 

Check Held 
to prevent 
an abstract 
from being 
exported 
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Creating a backup 

When logging off and exiting Abstract Plus, the application will prompt you to back up the current abstract database. To 
log off/exit Abstract Plus and use the database backup option, complete these steps. 

1. Exit Abstract Plus.  The Exit Program window opens, and asks if you are sure you want to exit the program. 

 

2. Click Yes. A window opens asking if you would like to back up the database containing your abstracts.  

 

3. If you would like to backup your database, click Yes. The Database Backup window appears. Select where you 
would like to save the backup if you don’t want the backups in the default location.  

 

4. Select the desired compression level for the zip file if other than the default. 

5. You can encrypt the file with a password if you’d like. Otherwise, just click Save to create the backup and exit 
Abstract Plus.  

! 

Although you can choose not to back up your database, it is highly recommended that you 
backup your database after finishing an abstracting session during which changes were made 
(abstracts were added, updated, or deleted). 

! 

If you password-protect your file, the encrypted file cannot be restored without the specified password. 
WCRS does not have access to this password, so if it is forgotten or lost, the backup cannot be recovered. 
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Restoring Abstracts from Backup 

In the event that your Abstract Plus abstracts database (ABSPLUS.MDB) is corrupted, if you have used the Backup option 
to back up your database you will be able to restore your database using the Restore Option.  The Restore Option 
allows you to go back to a file that you saved which is why it is so strongly recommended that you back up your work 
when exiting the application. To use the Restore Option to restore your Abstract Plus abstract database to an earlier 
saved backup, complete these steps. 

1. Open the Restore Database window from the File Menu. The Restore Abstract Plus Database opens. 

 

2. Navigate to and identify the zipped backup file on your computer or network by clicking the Folder Icon. Note: The 
default location for saving backup files is C:\RegPlus\AbstractPlus\MDBS\Backup. You may need to navigate to a 
different location if you saved your backup file somewhere else. 

3. If you password protected the selected backup file, enter the password in the Password Box. Otherwise just 
click Restore. Result: The main window opens with the selected abstracts backup database restored, and you 
can resume abstracting activities.  
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Deleting Abstracts  

Abstract Plus allows you to delete abstracts from the abstract database. This feature should be used with caution, as 
abstracts are permanently deleted from the database.  To delete an abstract, complete these steps. 

1. Click on the Utilities Menu, and select Delete Abstract(s). Result: The Delete Abstracts window opens. 

2. Enter your search criteria, and click Query. In the example shown, the abstract for the patient named Jane Doe 
is being searched for and deleted, so a “D” is entered in the Patient Last Name Box. By default, all cases will be 
selected. Make sure you deselect any cases you want to keep. Select only the case(s) you want to delete. 

3. Click Delete. Result: The system verifies that you would like to delete the selected abstract(s), and creates a 
backup.  

By default, all 
cases are 
selected. 

Deselect any you 
wish to keep. 

 

Click Delete 
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Other Functions 
Doctor Search 

To lookup a doctor you can use the Doctor Query System (DQS). The DQS contains information for Wisconsin-licensed 
Physicians and is updated by WCRS periodically. 

1. Click on the Utilities menu, and select Doctor Query System or click                on the toolbar. Result: The Doctor 
Query System window opens. 

2. Enter the search criteria of your choice and click Query. Result: Doctors meeting the criteria are listed. 

 

  

 

Enter Search Criteria 

Click Query 
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Printing an Abstract 

1. Open the abstract you wish to print. Click Select Print Current Abstract from the File Menu or click              on 
the toolbar.  

2. Result: The Report Viewer opens with a print preview of the abstract to be printed.  For the majority of fields, 
the coded value and the label are printed. 

3. Click Print or Save to print or save the abstract in the format of your choice.  

Print or Save 
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Printing a Range of Abstracts  

1. Click on the File menu, and select Print Range of Abstracts. Result: The Print Abstracts window opens. 

2. Enter the abstract selection criteria for the range of abstracts that you would like to print. Click Select. Result: 
The system displays the number of abstracts that meet the selected criteria at the bottom of the window. 

3. Click Print Preview. Result: The Report Viewer window opens.  

4. Click Print or Save. 

  

Number of abstracts to 
be exported is shown 

Click Select 

Enter 
Selection 
Criteria 

 

Print or Save 
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Running Reports 

1. To run a report, go to the Reports menu and select the report of interest. Result: You will either be directed to a 
window to specify more criteria, or you will be taken directly to the Print Preview of the report.  

2. Save or Print your report. 

 

Report Description 

Accession Register  
Includes a line listing of all abstracts in the database, sorted by reporting 
hospital and accession number 

Patient Index 
Includes a line listing of all abstracts in the database, sorted alphabetically by 
name 

Selected Cases Line listing report which includes abstracts based on user-specified criteria 

Status Report (Count of Cases) 
Summary…  

Includes the total number of complete and incomplete abstracts by export 
status within a user-specified date range 

Completion Status of Abstracts by 
month  

Includes abstract completion status by year and month of Date of Adm/1st 
Contact within a user-specified date range  

 

 

Print or Save 
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Appendix I. Helpful Keyboard Shortcuts 

Function Keyboard Combination 

Save Abstract Ctrl+S 

Run EDITS on current Abstract F8 

Undo text change Ctrl+ Z 

Cut selected text Ctrl+ X 

Copy selected text Ctrl+ C 

Paste text from clipboard Ctrl+ V 

Select All text in entry field Alt+ A 

Move to next field Enter or Tab 

Move to previous field Shift+Enter or Shift+Tab 
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Appendix II. How to Set Default Values for NPI and Facility Codes 

Follow these instructions to set default values for fields. This eliminates the need to look up and enter values individually 
for each abstract.  This is especially helpful for NPI and Facility Codes fields. 

 

 

 

 

1. From the Administration menu, select Manage Abstract Display Types. Result: The Administrator Login 
window will appear. You will be prompted for a password. Enter Admin. 

 

2. Result: The Manage Display Types window will open. Click on the Display Type you wish to configure.  
 

! You need to repeat these steps for each Display Type  
(1976-2017 Diagnoses and 2018-Present Diagnoses) 

Select the 
Display you 
wish to 
configure 

Click Display 
Fields  

 Admin 
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3. Result: The Display Fields tab will open. Select your desired field from the right column and click Properties. 

 
4. Result: The Properties window will open. Enter your information (such as WCRS 10-digit Facility ID or NPI code) 

in Field Default Value. Click OK.  

 

5. Result: You are returned to the Manage Display Types window. Click Save. Repeat the steps for each display 
and each field you would like to default. When done, the field(s) will be defaulted to your set value in new 
abstracts you create. 

 

Highlight the 
field you wish 
to configure 

Click 
Properties 

Enter your 
Default Value 

Click OK  
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Appendix III: Text Field Recommendations and Requirements 

There are various text fields that need to be filled out in abstracts.  The following text is provided to help you understand 
the information needed in the text fields. The following examples reflect a prostate cancer diagnosed in 2018.  

PE Requirements

 
 Age, sex, marital status, race and ethnicity  

 Prior cancer history (previous cancers diagnosed and when) 

 Date of physical exam  

 Impression (when stated and pertains to cancer diagnosis) 

 Recommendations: 

 Behavioral risk factors (smoking history, etc.)  

 Family history of cancer   

Imaging Requirements 

 Date(s) of X-ray/Scan(s)  

 Tumor location and size 

 Lymph nodes  

 Distant disease or metastasis  

 Primary site and Histology (if given)  

 Positive and negative clinical findings. Record positive results first. 

Scope Requirements 

 Date(s) of endoscopic exam(s) 

 Record site and type of endoscopic biopsy 

 Tumor location 

 Tumor size 

 Primary site 

 Histology (if given) 

 Record positive and negative clinical findings. Record positive results first. 

Labs Recommendations 

 
 Type of lab test/tissue specimen(s)  

 Record both positive and negative findings. Record positive test results first.  

 Date(s) of lab test(s)  

Labs Notes 

 Information can include tumor markers, serum and urine electrophoresis, special studies, etc.  

 Tumor markers include, but are not limited to:  
o Breast Cancer – Estrogen Receptor Assay (ERA), Progesterone Receptor Assay (PRA), Her2/neu.  
o Prostate Cancer – Prostatic Specific Antigen (PSA)  
o Testicular Cancer – Human Chorionic Gonadotropin (hCG), Alpha Fetoprotein (AFP), Lactate 

Dehydrogenase (LDH) 
o Melanoma Skin – Lactate Dehydrogenase (LDH) 
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OP Requirements 

 Dates and descriptions of biopsies and all other surgical procedures from which staging information was derived 

 Number of lymph nodes removed (if not documented in pathology text field) 

 Size of tumor removed (if not documented in pathology text field) 

 Documentation of residual tumor 

 Evidence of invasion of surrounding areas (if not documented in pathology text field) 

 If surgery planned but not performed; reason primary site surgery could not be completed 

Pathology Requirements 

 
 Date(s) of procedure(s) and type of tissue specimen(s)  

 Tumor type and grade (include all modifying adjectives, such as predominantly, with features of,  with foci of)  

 Tumor size and extent of tumor spread 

 Involvement of resection margins  

 Number of lymph nodes involved and examined  

 Positive and negative findings. Record positive test results first.  

 Recommendations: 

 Note if pathology report is a slide review or a second opinion from an outside source (AFIP, Mayo, etc.).  

 Record any additional comments from the pathologist, including differential diagnoses considered, ruled out 
or favored. 

Primary Site Text Requirements 

 Location of the primary site of the tumor (including subsite) and tumor laterality 

Histology Title Requirements 

 Histologic type (adenocarcinoma, sarcoma, CLL, squamous cell, etc.) and behavior (benign, in situ, malignant) 

 Grade Clinical, differentiation from scoring systems such as Gleason’s Score, Bloom-Richardson Grade, etc.  

 Stage Requirements 

 Tumor Size (if not documented in pathology text field) 

 Date(s) of biopsy and/or other procedure(s) (including clinical) that provided information for  assigning stage (if 
not documented in pathology text field) 

 Extent of tumor (depth of spread in primary and other organs involved by direct extension) (if not documented 
in pathology text field) 

 Status of margins (if not documented in pathology text field) 

 Number and sites of positive lymph nodes (and condition of nodes if applicable – matted vs. moveable) (if not 
documented in pathology text field) 

 Site(s) of distant metastasis (if not documented in pathology text field) 

 Notation of TNM and summary stage schema specifics, if known (recommended) 
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Primary Site Surgery Requirements 

 Date and type of each surgical procedure (incl. excisional biopsies and surgery to other/distant sites). 

 Document if lymph nodes, regional tissues or metastatic sites were removed; if so, document LN number or site. 

 Facility where each procedure was performed. 

 Positive and negative findings. Record positive findings first. 

 Other treatment information, e.g., planned procedure aborted; unknown if surgery performed 

Radiation Requirements 

 Date beam radiation began or reason why it was not given (patient refused, patient died,  contraindicated, etc.). 

 Where beam radiation was given; e.g., at this facility; at another facility.  

 Type of beam radiation as defined in the STORE Manual (e.g. Photons [MV range], Orthovoltage, Cobalt-60, IMR) 

 Type of non-beam radiation; e.g., High Dose rate brachytherapy, seed implant, Radioisotopes (I-131). 

 Recommendations: other treatment information; e.g., patient discontinued after 5 treatments; unknown if 
radiation treatment was given.  

Chemo Requirements 

 Date chemotherapy began or reason why it was not given (patient refused, patient died, contraindicated, etc.). 

 Where chemotherapy was given; e.g., at this facility; at another facility.  

 Type of chemotherapy, e.g. name of agent(s) or protocol.  

 Recommendations: other treatment information; e.g., treatment cycle incomplete; unknown if chemotherapy 
was given.  

Hormone Requirements 

 Date hormone therapy began or reason why it was not given (e.g. patient refused, patient died, contraindicated) 

 Where hormone therapy was given; e.g., at this facility; at another facility.  

 Type of hormone or antihormone, e.g., Tamoxifen. 

 Recommendations: type of endocrine surgery or radiation, e.g., orchiectomy and other treatment information; 
e.g., treatment cycle incomplete; unknown if hormones were given.  

BTM Requirements 

 Date BRM began or reason why BRM was not given (patient refused, patient died, contraindicated, etc.) 

 Where BRM was given; e.g., at this facility; at another facility.  

 Type of BRM agent; e.g., Interferon, BCG.  

 BRM procedures; e.g., bone marrow transplant, stem cell transplant. 

 Recommendations: other treatment information; e.g. treatment cycle incomplete; unknown if BRM was given. 
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Other RX Requirements 

 Date other treatment began or reason why it was not given (patient refused, patient died, contraindicated, etc.). 

 Where other treatment was given; e.g., at this facility; at another facility.  

 Type of other treatment, e.g., blinded clinical trial, hyperthermia. 

 Recommendations: other treatment information; e.g., treatment cycle incomplete; unknown if other treatment 
was given.  

Place of Diagnosis Requirements: Manual documentation of the facility and/or physician office where the diagnosis was 
made. 

Misc. Remarks Requirements 

 
 Justification of over-ride flags (if an over-ride flag is set) 

 Justification of transplant/endocrine surgery field 

 Information clarifying anything unusual, such as reason for reporting a case seemingly not reportable for that 
facility, or reason for coding numerous fields as unknown. 

 Recommendations: 

 Smoking history  

 Family and personal history of cancer  

 Comorbidities  

 Information on previous cancers if a person was diagnosed with another cancer out-of-state or before 
the registry’s reference date  

 Place of birth if available 
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Appendix IV: 3.8 Changelog 

Added 

 Wisconsin-specific Abstract Plus Edit Metafile, NAACCR V18D (See edit changelog for details) 

 Field “Grade Pathological” to “2018-Present Diagnoses” display 

 “Grade Post Therapy” to “2018-Present Diagnoses” display 

 “Override CS 20” to “2018-Present Diagnoses” display 

 TNM Fields to the “1976-2017 Diagnoses” display 

 Hidden Protected field “CoC Accredited Flag” to “2018-Present Diagnoses” display and set default field 

value to “0” 

Changed 

 Update doctor table to reflect current Wisconsin licenses 

 Remove “WI-” from the beginning of names in facility lists 

 Change “2018 Diagnoses ONLY” to “2018-Present Diagnoses” to avoid confusion 

 Display Label for field "Text-DX Proc--Lab Tests" now reads "Labs - ER/PR/HER2, LDH-melanoma, PSA, 
MSI-colon"  

 Display Label for field "Text--DX Proc--Op" now reads "OP - bx,surg procs,dates,types" 

 Display Label for field "Text--DX Proc--Path" now reads "Pathology - dates, bx/surg, size, depth, LN, 
grade" 

 Calculate SS2000 in “1976-2017 Diagnoses” display 

 Set “Physician—Follow-up” as critical field 

 Set “Schema ID” as critical field in “2018-Present Diagnoses” display 

 Remove default value “9999999999” from "Reporting Facility" field in “2018-Present Diagnoses” 
display 
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Appendix V: User Support 

For technical support via e-mail, contact Jenna Staehler at WCRS: jenna.staehler@dhs.wisconsin.gov. Issues outside the 
scope of WCRS user support will be directed to CDC Registry Plus Technical Support.  
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